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Copy And Paste 

Not Working 

My copy/paste operation has failed. Is there a way to 

fix it? 

This is a typical question where not quite enough 

information has been given. It really is surprising how 

many people think that because they have a problem you 

will know the answer.  

"My computer has stopped working can you tell me what 

is wrong please?" 

So, let's try and take a stab in the dark and answer the 

question. I'm not sure what you are trying to do but in 

word and/or Excel, the clipboard is only capable of 

holding up to 24 items. You may have closed word or 

Excel and are working in the other program, but the 

clipboard is still holding your items. The computer 

doesn't know that you no longer require the data that's 

on the clipboard. Here's what to do. 

In Word make sure you are on the Home tab and click 

the arrow under the Paste in the Clipboard tab. 
 

 
Figure 1: The Clipboard Tab 

 

Clipboard 

Contents 

Clicking this will show the contents of the clipboard. 

Note that there are three items on the clipboard 

 

 
Figure 2: Clipboard Contents 
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Clear Clipboard 
To clear the clipboard click the small corner arrow to 

the right of the word Clipboard. A type of dialog box will 

appear showing all the copies on the clipboard up to this 

point. Click the Clear All button and voila, the clipboard 

is empty. The only other way of clearing the clipboard is 

to close down all office programs. 
 

 
Figure 3: Clear Clipboard 

 

Clearing 

Individual 

Items 

Click the small right hand arrow after word Clipboard (as 

in above note). If there is more than one item listed it's 

possible to click the clipboard item and a small arrow will 

appear to the right. 
 

 
Figure 4: Click Clipboard Item 

 

 
Click that small downward pointing arrow and you may 

now paste or delete the item from the clipboard as an 

individual item. 

The clipboard is a very handy tool and it is worth playing 

with to see some of its functions and capabilities. 
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The Alt 

Shortcut Keys 

In 2007 and higher have you ever typed the Alt key on 

its own and seen all the little letters and figures appear 

in the Ribbon? More to the point, do you know why they 

are there? Here are some shown below in a screen shot 

of the plain Ribbon. 
 

 
Figure 5: The Ribbon 

 

 
If the Alt key is pressed then numbers and letters will 

also display on the ribbon. 
 

 
Figure 6: Ribbon With Alt Key Typed 

 

 
The Ribbon is the same but different, why all the letters 

and numbers. 

Let's look at the letters first. Up until version 2007 of 

Office all programs had in them a letter underlined in 

each menu item, using the Alt key plus that letter would 

move you to that menu. IE. Alt + E opened the Edit menu. 

This changed in version 2007 there was no more menu 

only the Ribbon. At first, it was so confusing to users 

that Microsoft wrote three utility programs with a 2003 

fully working pseudo menu. When an item was clicked on 

the ribbon opened and where the same item could be 

found it was highlighted. These utilities are still 

available in versions 2010 and 2013. However, Microsoft 

didn't fully abandon the old method, type the Alt key 

now and the Ribbon display letters, which when typed will 
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open that Ribbon.IE. JL will open the layout Ribbon 

section. The numbers are the items on the Quick Access 

Toolbar. My number 4 opens the Delete Table options 

with all the options also short-listed. The numbers are 

the numeric keys not the F number keys.  

This part of 2007 + means you no longer have to 

remember the short cut keys the program guides you to 

them. Try them out you may just be a little surprised at, 

not only how nice it is to work this way, but also how 

much faster it is. 
 

Word 2007 

Line Spacing 

Several question have been put to me on how to set the 

line spacing on a document. Setting line spacing (the 

space between the lines) is easy but don't leave the 

Set-up there. Included in the listing are many of the 

defaults that are needed in a document.  

Resetting the default, so that all new documents open 

with the line spacing of your choice and like everything 

else with computers not difficult once you know how. 

Method One: 

For a new document that you don't want on the default. 

In the Home tab on the ribbon click the Line Spacing 

Icon  
 

 
Figure 7: Line Spacing Icon 
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In the above I have clicked just the line spacing icon 

notice the icon tip is displayed. Alongside of the icon is a 

small downward pointing arrow. Click this and you will see 

the different line spacing setting available to you.  
 

 
Figure 8: Line Spacing Available 

 

 
It isn't even necessary to select one and close the 

listing to see what it looks like. Slowly run the cursor 

down the list and as each one passes under the cursor 

the document line spacing changes for this paragraph 

only at this point. When you have the one required click 

it to set it. You may also Add or Remove a space after a 

paragraph at the bottom of this listing.  
 

Setting Default 
It is also easy at this point in time while it's on your 

mind to set this as the default for future documents. 

Click the little arrow to the right of Change Styles icon 

and the click the manage styles button. 
 

 
Figure 9: Arrow To Right Of Change Styles 
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On the menu that appears it's the bottom right hand 

icon. Note some of my screenshots have slight 

differences because I'm using Office 2013 
 

 
Figure 10: Bottom Right Icon 

 

 
Now you can set the defaults of Font, Style and Line 

Spacing. If you want this to apply to all future 

documents click the option button for this. (New 

documents based on this template). This changes the 

New Document Template, which will remain for all new 

documents until it is reset again.  
 

 
Figure 11: Set Default Options 
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Word 2010/13  
In word 2010 and 2013 there are slight differences in 

the places thing are shown on the ribbon. This is 

basically because Microsoft can't leave things alone they 

have to try to fix what ain't yet broken. Look under the 

Home tab on the ribbon and you will find the information 

you are looking for. One thing I try to avoid is to rely on 

finding the answer in the MS Help file. You often find 

that what you ask for is buried deep in some other piece 

of information. The best place to look is to ask the same 

question in Google. Don't get despondent if you don't 

find the answer right off – look down through the forum 

listings through to the end or until you find what you 

want. 
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Default 

Settings 
I am unable to get a grip of what is meant by a default 
setting with computers. At school a defaulter was 
someone that had done something wrong. When you owe 
money on a mortgage or loan a default is a penalty for 
not paying on time. Can you explain what a default is on a 
computer?  

Yes, and I can see your point, it almost seems as though 

you have your cake and eat it at the same time. The 

dictionary definition of a default can be a noun or verb 

Noun 

Failure to fulfil an obligation, esp. to repay a loan or appear in  

A court of law. 

Verb 

Fail to fulfil an obligation, esp. to repay a loan or to appear in  

A court of law: "some had defaulted on student loans". 

Computer Default 

This term is used to describe a pre-set value for some 

option in a computer program. It is the value used when a 

setting has not been specified by the user. For example, 

the default font setting in Windows 2007 is "Calibri". If 

you don't like this preference and change it to 

something else, like "Times" the "Times" font will be 

used in future -- by default. Typically, default settings 

are set to what most people would, or Microsoft decides 

they would choose anyway, so there's often no reason to 

change them. If, on the other hand, you're one of those 

people who has to customize everything that you possibly 

can, then you can go ahead and change all the default 

settings you want. 
 

Convert Table 

to Text 

If you remember on the Word 2003 version it was a 

simple matter to change a table to text and text to a 

table. I've heard many comments that this is not 

available in Word 2007 and higher versions. It most 

certainly is but it's a little harder to find and for new 

users of Word 2007 it's not in the menus any longer but 

in the Layout Tab in the Data section. 
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Figure 12: Word 2003 Menu Option  

 

 
Figure 13: Word 2007 Option 

 

Using Word 

Menu Ribbon 

Converter 

There is a converter utility program available from the 

Word 2003 menus to Word 2007 ribbon. It converts 

from 2003 – 2007 through to 2013. I've seen people 

using this conversion utility and many of them look up 

the item they want and once found close the utility down. 

This really is a waste of time because the next time that 

you need it in that session, you have to open it again. 

Let's look at the utility in the ribbon form – that is 

you've looked for something and found it and you close 

down the utility and go back to the Word program.  

Now if you look at your task bar you will see something 

like that show here. 
 

 
Figure 14: The Task Bar 

 

 
All I have open is the word program with the Word tips 

for… open. It's quite simple to keep the utility open also. 
Look at the following task bar. 
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Figure 15: Task Bar With Two programs Open 

 

 
The macro program on the right is the utility program 

open. 
 

Figure 16: Microsoft utility Open 
 

 
When you click in any of the 2003 menus and select what 

you want the utility will open into the 2007 ribbon and 

display where the item can be found. 
 

 
Figure 17: Utility With Ribbon Shown  

 

Getting Back 
"That's all very fine but the next time I open the utility 
it's already showing the ribbon."  
Well, yes if that's what you want, but to get back to the 

2003 screen display, when you've finished with the 

program the first time, click the little "X" button as you 

normally would to close a program. What this does is 

close the 2007 ribbon screen display and takes you back 

to the 2003 menu display. Now in the task bar click on 

the Word 2007 item and that will open and the utility 

will automatically remain in the minimised state on the 

task bar until required again. Learn to work with the task 

bar and as many as 5 programs open at the same time if 

you wish. I usually limit it to 4 programs as otherwise 

the task bar gets crowded. 
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Formatting 
One of the worst things you can do with a document is to 

not worry about how it is formatted. Formatting is one 

of the most important things with a document to make it 

legible and easily readable. Have you ever received a 

badly formatted document that was hard to read? You 

soon get fed up or annoyed with the layout and discard 

the rest of it. So then what makes one document easier 

to read than another? 
 

Layout 
Layout is quite important, in fact Word 2007 makes it 

one of the ribbon tabs. So what is in the layout of a 

document that people don't like?  

Small and large print all jumbled up together. 

Too many fonts in the same document. 

Not enough white space. 

Margins too small or too big. 

Breaking text across a line with a picture or graphic.  

Those are the most common errors that people make 

when formatting documents. 

What looks good on screen is not necessarily good on 

printed paper. Always print out a document to see how it 

looks. 
 

Copying 

Defaults 

Ever had a document that is in Arial font and copied and 

pasted something from another document but the 

format is in Times New Roman. 
This is what happens and what the outcome looks like. The 
current font is Arial 12 pt. Let's move the font to Times New 

Roman the size has not changed it's still 12 pt. But as soon as it 
moves back to Arial it becomes annoying. 
 

Changing Font 

Beforehand  

It's quite simple to copy the text beforehand  

Do the copy with Ctrl + C (or whatever method you use 

to copy. 
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Copy the content from the source to the Clipboard using 

[Ctrl]+C. 

In the destination document, position the cursor and 

then click the Home tab. 

In the Clipboard group, choose the Keep Text Only 

option shown in from the Paste drop-down.  

In Word 2007, choose the Keep Text Only option from 

the Paste Options (smart tag) drop-down after pasting 

the content. 
 

 
Figure 18: Clipboard Group In Ribbon (Keep Text Only) 

 

 
When the copied text comes into the document it will 

come in at the current document's (the one being copied 

to) format. 
 

Using Auto 

Correct To 

Format 

"Hey, come on Bob auto correct is for correcting 
regularly incorrect spelling mistakes like recieve, instead 
of receive".  
Yes you're right and at the same time you're wrong. 

Auto Correct does what it says it does in its name it 

Automatically Corrects mistakes. In this case the 

mistake is made consciously like this w2007 is replaced 

with Word 2007. 

So how's it done? Look at the screenshot below to see 

the finer workings. 

Type in your short cut and highlight it. 

Select File tab from the ribbon. 

Select Options from the listing. 

Select proofing from the list. 

Select Auto Correct at the top of the menus.  
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Special Text 
Enter up the w2007 and then the correction Word 2007 

each time in future when you type that, as soon as you 

enter the space bar after the w2007  then it will be 

replaced with what you want it to be replaced with. 

You may also do this type of thing. 

"Wellington Regional SeniorNet"     
 

 
Figure 19: Auto Correct ws2007 to Word 2007 

 

 

Figure 20: Formatted AutoText 
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Auto Text 
Summary 

In the above to get wrs to give the formatted type face 

and size, make sure the Formatted text option is clicked. 

"Wellington Regional SeniorNet" Now 

type in the text letters. I do this with any special 

document I'm writing to save time and make it easy. 

Once the document is finished go back and remove the 

special Auto Correct statements. 

So, to summarise Auto Text, it can be used for many 

more things than at first meets the eye. Use it to your 

advantage. Why make work for yourself when you have a 

computer that can do it for you? 
 

Formatting 

Wrap-up 

There are a few more tricks I use in the formatting of a 

document. I am not going to tell you all of these in one 

place, you'll read them and forget them. Try these tips 

out and use them to your advantage and later in a new 

set of Tips I'll pass on some more.   
 

Cropping 

Graphics 

Have you ever cropped a graphic and then later wished 

you hadn't, because you actually cropped something out 

of the picture that you'd like to use elsewhere? It's not 

lost when you are in Word the cropping of the picture is 

just hidden. 
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I'm going to crop the picture above to show what I 

mean. 
 

 
Figure 21: Cropped Picture 

 

 
Here I've cropped out the fence at the bottom of the 

picture. 
 

 
Figure 22: Fence Not Tree 
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I've then copied the picture and cropped it the other 

way by taking out the tree and using just the fence. Try 

this out for yourself. One thing I found this handy for 

was cropping a picture in Word then placing it in a web 

page, (with a copy and paste) and later still being able to 

alter the web page picture without the necessity of 

returning to the word program.   
 

Keep Words 

Together 

To keep two or more words together on the same line, 

it's necessary to insert a nonbreaking space character 

between them. To do this press the key combination 

[Ctrl]+[Shift]+[Spacebar]. The space between the two 

words will look like a normal space but Word will keeps 

both words on the same line. 

If you have a hyphenated word and you need them on the 

same line, like right-hand. Then use the same key 

combination except use the hyphen character instead of 

the spacebar. If the word that you want to keep all as 

right-hand, if word is unable to place it all before the 

margin then the whole of the words with the hyphen will  

wrap to the next line 
 

Show Hide 

Header And 

Footer 

I used to have my header and footer showing in my Word 
2003, I'm sure it used to be there in 2007 but it's gone 
and I have no idea how to get it back, any Ideas?  
Well, yes I have now after doing a bit of research on the 

problem. 

As far as I can tell it's all been caused by you double 

clicking without realising that you have done so. Because 

you didn't realise you had done it you wouldn't try to 

correct it that way either. I'm not sure about 2003 but 

this does work in 2007 and as far as I can tell in 2010 

but it doesn't work this way in 2013. What you do is place 

the cursor on the line between the top of the page and 

the border between the page and ruler. The cursor will 

turn to two small arrows pointing at each other – now 

double click between the two arrows. 

Voila your header and footer should now be visible again. 

I'm unable to give you screen shots of this as I use 2013.  
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Typing Is 

Slowed 

"I am a touch typist and type at about 50 wpm in word 
the characters on screen appear very slowly. Effectively 
this slows my typing down, can I do something about 
this"? 
First ask yourself is this problem confined to word or 

does it also happen in other programs? If it does then 

this is an old fault that people come across and has 

nothing to do with word or any other application program 

you are using. You need to set-up your Windows 

correctly. Here's what to look for and do.  

Click the Start button 

Select Control Panel 

Move down the list and click Keyboard 

Make sure you have the Speed tab open. 

Adjust the buttons, for Repeat delay, repeat rate and 

Cursor blink rate. 

Click in the Test box and try out the speed of your 

keyboard. Make the settings to suit your typing speed. 
 

 
Figure 23: Keyboard properties 
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The above sets just your overall keyboard speeds if your 

rate is still slow in Word only, then check out this fix on 

the Internet. It's too long to place in these notes. 

http://www.howtogeek.com/74007/how-to-speed-up-

microsoft-word-2007-and-2010/ 

 

This is a great site to pick up all sorts of tips. 
 

Word 2010 

Find All Times 

A Word Is 

Used  

Ever looked for a word in previous versions of Word? 

You use the Ctrl+F key combination and type in your 

word. Then if that's not the one you want you have to 

click Find next. Your poor old finger can go numb with 

the frustration of keep clicking. 

There's a special little feature in Word 2010 which will 

find all of the repeats of the word without the clicking. 

This is how it's done. 

Open View on the Ribbon. 

Click on the Navigation Pane.  
 

 
Figure 24: View Navigation 

 

 
You'll see the following in the side panel of the screen. 

 

 
Figure 25: Navigation Panel 

http://www.howtogeek.com/74007/how-to-speed-up-microsoft-word-2007-and-2010/
http://www.howtogeek.com/74007/how-to-speed-up-microsoft-word-2007-and-2010/
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Click the right-hand (third tab) or the Results Option. 

You will see the search box where you type in the word 

to search for. Type the Enter key once. 
 

 
Figure 26: Results Option 

 

 
In the next screen shot I have gone mad and asked the 

search to look for the word "then" without the quote 

marks. The following screen shot is the result.  
 

 
Figure 27: Searching For "then" 
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The first instance of "then" is highlighted on the left 

with a bordered box around the word. In the right-hand 

side of the screen that particular instance of the word 

is highlighted. 

At the top of the Navigation section is the number of 

instances of the word and which one we're viewing, in 

this case 2 of 15. 

To the right of that is two small arrows up and down. 

Clicking the appropriate arrow will move the highlighting 

to the next or previous time the word appears in the 

text. You may still edit the document albeit that the 

Navigation panel is displayed. Don't mistake this for a 

Find and Replace like we're used to, it's not and neither 

is it meant to be. It is purely and simply a word 

searching assistant. It is also possible to scan through 

the document looking for the particular instance of the 

word being searched for by using the keyboard arrow 

keys. In this case the right-hand side of the screen will 

not move. However when you have found the right place 

type the Enter key once and you will be placed at that 

point in the editing screen. It comes back to the old, old 

storey, make the computer do the work not you.   
 

Mirror Text 
"I do a few pamphlets for our club and often I would like 

to add mirror text how do I do this"? 

That's a good question and in a nutshell the answer is as 

simple. You can't, well not simply. I've seen ways of 

fudging it using text boxes and 3D methods and even one 

using the Paint program. But when it comes down to it 

these all leave a little to be desired, either in simplicity 

or output. Using drawing programs can be a bit daunting 

unless you have a really good one that will handle text 

well and keep the sizing correct.  
 

Drawing 
Method 

I use a drawing program called Xara. I use version 2, 

which is long in the tooth it's seen several updates since 

I purchased it and is a lot more useful nowadays. I don't 

need any better than I've got for what I want, so why 

update. I'm sure your favourite drawing program could 

be used if it has a text option.  
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This is the kind of result it will produce. I've just used 

my name as an example. I've used a Comic Sans Font of 

14 point and used my name Bob Pretty with a left to 

right presentation. 

        
The size used was the same size as the text is written in 

12pt. In the next one the same text was used with a 

right to left presentation. Because the Xara program is 

so good at the job the text can also be mirrored quickly 

with top to bottom methods as shown next. 

 

     
 

This kind of thing in Xara is very quick to accomplish, I 

have used it to good effect on labels for home made 

produce, greeting cards and all sorts of other places. 

The thing is not to use it too often, while adding colour 

makes it really stand out.   

 
 

 

Automatic 

Indents With 

Word 

You're typing away like a busy little beaver and you wish 

to add a list, which you want to bullet, number or letter. 

This is simple just click the menu icon in the Home tab 

of the ribbon and voila the list becomes bulleted. 

Let's see this in action. The list will be objects on the 

computer. 

 

Keyboard 

Mouse 

Flash drive 

Video 

Wi Fi Modem 

CPU 

Printer 

To list this, you can type it and then hit the list button 

in the ribbon picking the bullet, numbering or lettering 

you wish. I've started this with a numbered list on the 

next page.  
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1. Keyboard 

2. Mouse 

3. Flash drive 

4. Video 

5. Wi Fi Modem 

6. CPU 

7. Printer 

The list has been altered by word to include the indent. 

To temporarily remove the indent, highlight the list and 

use the decrease icon in the Paragraph tab. 

 
 

I've done it with the same list below here. 

1. Keyboard 

2. Mouse 

3. Flash drive 

4. Video 

5. Wi Fi Modem 

6. CPU 

7. Printer 

 

The list (this one) will act the same if added to. If 

however you start a new list in the document then that 

list will be indeneted. 

1. Chicken 

2. Porterhouse 

3. Lamb chops 

4. Pork chops 

5. Minced Beef 

6. Topside 

7. Rump 

Now comes the question how do we do this for the whole 

document? 

The answer is quite simple once you know how. It is only 

semi permanent, in other words it works in this 

document and edits to it but not new documents.  
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After making your list double click any item in the list. 

Right click any item now in the list and from the drop-

down select Adjust List Indents. Word 2013 users do 

not need the double-click first. 

 

 Chicken 

 Porterhouse 

 Lamb chops 

 Pork chops 

 Minced Beef 

 Topside 

 Rump 
 

 
Figure 28: Adjust List Indents 
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Adjust List 

Indent 

Doing the above will display a dialog box (yours may be 

different to mine but they do the same job). Here's a 

screen shot of mine. Settle the adjustments to produce 

what you require. The item Follow number with Tab 

character can be changed for a space or nothing. Before 

playing with the indent paly with this Follow Number 

with. Just make a selection and click Ok, or type the 

Enter key. I usually set my changes to 0 cm for the 

Bullet position and .25 cm for the text indent and a 

Space for the Follow Number with. You will find that 

once this is set in a document that all future lists in that 

document will produce the same. It is therefore a semi 

permanent fix but for that document only. 
 

New Table 

Features In 

Word 2013.  

Working with tables for some reason gives some users a 

lot of grief. I get told all sorts of stories about how 

difficult it is to add rows or columns and to merge 

columns etc. I personally have never found it that 

difficult but before I start to alter a table in this way I 

always save the document. This ensures that if I make a 

complete mess of what I was supposed to be doing I can 

always close the document (without saving it) then go 

back and start again. This is not rocket science it's plain 

common sense. 

The new features of the 2013 table manipulations is 

pretty good, new rows and columns are a doddle and the 

new formatting features are great. 
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New Rows And 
Columns 

In older versions of Word to insert new columns of rows 

meant clicking a few times. It wasn't the clicking that 

upset most novice users it was the getting into the right 

place to make the click. In 2013. I'll insert a table here 

and show what I mean. Here I've inserted as 4 row table 

by hovering the cursor in the margin, I can add a row or 

by hovering over the top of the table I can add a column. 

This is done by clicking the small cross that appears.   

  

    

Insert Above    

    

    

      

 

 
This is how easy 2013 makes inserting a column or row. 

If in this case we had gone to the lower line then the 

row would have been inserted below the wording. The 

cursor plays no part in this operation, it can be in any cell 

of the table.  
 

New Formatting 
Options 

When formatting a table the best way is probably going 

to the styles. The new gallery places them into 

categories of lists and grid styles. The Table Styles are 

found in the ribbon on the Design tab.   
 

 
Figure 29: Table Styles 
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Click the small arrow shown here and the table styles will 

be presented on screen. These are in three groups, Plain 

Table, Grid Table and list Table. Make selections for the 

type of table you wish to format. There are a very good 

number to choose from but you may also Modify the 

Style, Clear it and make a new Table Style. As I always 

say play with these and see what they do. Don't do this 

with something you are working on do it in a practice 

piece of work. It's also possible to work on a specific 

row or column and an individual cell. Direct formatting 

hasn't really changed all that much but you have more 

choice on setting the borders. 

To see these changes click in the Borders Gallery, click 

any one from the borders available. This can apply to a 

cell, column or row or the whole table. Play with them to 

find out what you can do. If you don't play you will not 

learn and some of these things are really worth knowing 

when you wish to do something different or make 

something stand out from the rest of the document.    
 

Change Save 

Default File 

Location 

Ever notice how in Microsoft office applications the 

default place to save files is always either My 

Documents (prior to MS Word 2007) it was necessary to 

click Tools Options and select the File Location tab. This 

tab gave several different options. Now in Word and 

other Office products in 2007 the method is,  

Click the File Menu 

Click Options. 

Click Save. 

Browse to the drive and folder you wish to use as the 

default. 

With that path shown in the text box. 

Click OK and your new default will take over next time 

you start any office program. This option changes MS 

Office 2007 default saving not just Word 2007. In the 

screenshot below you'll see my default is my F:\ drive, 

which I use strictly for data, my C:\ drive is for the 

operating system Windows 7 and my application 

programs only. 
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Figure 30: The Save Options 

 

 

 


